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Chapter 1  
Computer Fundamentals 

Objective: 

 Computer 

 Advantages 

 History 

 Classification 

 Components 
___________________________________________________________________________________________ 

Computer 

“Computer is an electro-mechanical device, which takes the Input from the user and, after Processing it, 
gives the Output to the user”. 

Input: Input means the commands or instructions, which a user gives to the computer to know the solution. 

Processing: The computer doesn't know our language. It only knows the Binary Language that is 0110011001100. 
Computer first converts our language to binary to understand and after that again converts the binary data to the 
user language so that the user can understand the result. 

Output: Output means the result given by computer against a specific input. 

Suppose a user wants to know the result of 2+2. In this case, 2+2 is the input. After taking this input, computer 
converts the 2+2 to binary language to understand the input, after that creates the result in binary and converts the 
result into the user language and then shows the result in monitor which is 2+2=4. This result is output. 

The Basic Advantages of a Computer 

Speed 

It can perform huge amount of work in a few seconds. Where human being worked on a particular work for whole 
day, computer does the same in very short time. Computer speeds are measured in Microseconds, Nanoseconds 
and even in Picoseconds. 

Accuracy 

The computer is 100% accurate and capable to perform arithmetical calculation and logical operations with the 
same accuracy. A computer can commit errors but at the fault of human beings. It may be due to inaccurate 
feeding of data or due to wrong setting by the programmer. 

Diligence 

If you work continuously for 3 hours, you feel lack of concentration, tired and monotonous but a computer is free 
from these and you will get the result you want with the same speed and same accuracy. 
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Versatility 

Computer can do multiple works. It is used in data processing jobs, weather forecasting, ticket-reservation purpose, 
multimedia designing, animation etc. 

Historical Development of Computers 

The modern computer is the end result of countless inventions, ideas, and developments by many people 
throughout the last several decades. The history of automatic data processing begins with Charles Babbage's 
attempt to build an automatic mechanical calculator at Cambridge, England, in 1830. The entire computer 
evaluation has been divided into certain number of generations. 

First Generation Computers 

UNIVAC (Universal Automatic Computer) was the first general purpose electrical computer to be 
available and marked the beginning of the first generation of electrical computers. The first generation 
electrical computers employed vacuum tubes. These computers were large in size and required air 
conditioning. The input and output units were the punched card reader and the cardpunches.  

Second Generation Computers  

These computers employed transistors and other solid-state devices. Their circuits were smaller than 
the vacuum tubes and generated less heat. Hence the second-generation computers required less 
power, were faster and more reliable. IBM 1401 was the most popular second-generation computer. 

Third Generation Computers 

These employed Integrated Circuits (IC) in which all the elements of an electronic circuit are 
contained in a tiny silicon wafer. The third generation computers are much cheaper and more 
reliable than the second-generation computers. The third generation computers permit use of 
such high level languages as FORTRAN and COBOL. The mini computers are also one of the 
developments in the third generation computers. 

Fourth Generation Computers 

Fourth generation machines appeared in 1970's utilizing still newer electronic technology, which enables them to 
be even smaller and faster than those of the third generation. Many new types of terminals and means of computer 
access were also developed at this time. 

One of the major inventions, which led to the fourth generation, was the Large Scale Integrated Circuits (LSI). The 
LSI is a small “chip” which contains thousands of small electronic components which function as a complete 
system. 

Microcomputers:  

In July 1977, at National Computer Conference in Dallas, Commodore Ltd. started the computing world by 
announcing a fully assembled microcomputer in a single housing called the Personal electronic Transact or PET. 
Later in 1977, Radio Shack Corporation announced the TRS 80 computer. 
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The IBM family of personal computers: 

In 1981, International Business Machines (IBM) made its first appearance in the field of microcomputer with the 
announcement of the IBM Personal Computers. The term personal computer captured the notion that an individual 
can have her or his own computer. With the advent of IBM PC, computers had stepped out of large organizations 
and entered into the home. However, instead of adopting 8-bit microprocessor, IBM selected Intel 8088 - a 16-bit 
microprocessor which made the IBM PC “an overnight success”. In 1983, IBM's first addition to the PC-family - XT 
model was introduced. AT model, which has a much greater computing speed than the PC and XT or even the new 
Desk Pro? When software vendors began to orient their products to the IBM PC, many microcomputer 
manufacturers created and sold clones of it. These clones called IBM PC compatibles run most or all the software 
designed for the IBM PC. 

Fifth Generation Computers 

Defining the fifth generation of computers is somewhat difficult because the field is in its infancy. The most famous 
example of a fifth generation computer is the fictional HAL9000 from Arthur C. Clarke's novel, 2001: A Space 
Odyssey. HAL performed all of the functions currently envisioned for real-life fifth generation computers. With 
artificial intelligence HAL could reason well enough to hold conversations with its human operators, use visual 
input, and learn from its own experiences. 

Classification of Computer 

 

ANALOG COMPUTER:  

A computer that represents data by measurable quantities such as voltages, the rotation of gears etc. in order to 
solve a problem, rather than by expressing the data as numbers. 

 

 
 

DIGITAL COMPUTER:  

It is a computer that stores and performs a series of mathematical and logical operations on data expressed as 
discrete signals interpreted as numbers, usually in the form of binary notation. 
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Digital Computer 

HYBRID COMPUTER:  

A computer system consisting of a combination of analog and digital computer systems is called a Hybrid 
Computer. 

 
Hybrid Computer 

Components 

There are two Components of computer:  

 HARDWARE 

 SOFTWARE 

HARDWARE: That type of device which we can see and touch and which is physically present is called Hardware 
device. Example: Mouse, Monitor, Keyboard, CPU etc. 

SOFTWARE:  The programs or anything that run on the computer are called Software. Technically, Software is a 
general term for the various kinds of programs used to operate computers and related devices. Example: MS 
Office, Tally, Coral Draw, VLC Media player, any games etc. 
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There are two types of software: 

i) System Software: That type of software which controls the total system of the computer is called System 
Software.  

OPERATING SYSTEM: 

Operating system is a System Software which is required for the computer to start up and it is an interpreter 
between Hardware & User. 

Few of the Operating Systems are as follows: 

1. MS WINDOWS: Windows 95, 98, 2000, XP, Vista, Windows 7. (GUI: Graphic User Interface) 
2. DOS (Disc Operating System) (CUI: Character User Interface) 
3. UNIX 
4. LINUX 
5. NOVELL NETWARE 
ii) Application Software:  

That type of software which runs under a particular System Software and used for a particular type of 
application is called Application Software. For example, the software needed for accounting work is 
“Tally”. For day to day official work like letter writing, calculation etc., the software is MS OFFICE. For 
designing purpose, the software is “Corel Draw”. 

GUI and CUI 

 If you go through all operating systems, you notice that they provide two interfaces - CUI (Character User 
Interface) and GUI (Graphical User Interface). 

 CUI stands for Character User Interface; it means that you have to type commands to interact with your 
computer. 

 GUI stands for Graphical User Interface; it means that you don't need to type commands to interact with your 
computer; instead you have to click with the help of mouse on the icons of readymade commands. 

Important: 

At least One System software is required for any computer. More than one System Software is also possible but 
minimum one is required; otherwise computer will not run. But there is no such criterion for application software. A 
computer can run without any application software. So, based on this concept, we can say that the relation 
between System and Application Software is just like Rail and Tracks in which Tracks are similar to System 
Software and Rail is similar to Application software. Rail works if the track is available, otherwise not.  

Booting: 

Booting is a process in which all the programs (including the Operating System) come to the RAM (Random 
Access Memory in which a user works while the computer is on), to give the user a workable interface. Peripheral 
detection is also a part of Booting in which the system checks the connectivity of all the devices with the computer.  

After the booting process, the first screen from where a user can start any work is called Desktop.  A bar on the 
bottom of the Desktop is called Taskbar in which a Start button on the left hand side and clock on the right hand 
side. 
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Summary 

 The advantages of computer are Speed, Accuracy, Diligence, Versatility etc. 

 There are two components of Computer. One is Hardware and another is Software.  

 Operating system is a System Software which is required for the computer to start up and it is an interpreter 
between Hardware & User. 

Assignment 

1. What is Computer? 
2. What are the advantages of Computer? 
3. What is the difference between System and Application Software? 
4. What do you mean by System Folders? 
5. What is the difference between GUI & CUI? 
6. What is Booting? 
7.  Give at list two example of all generation computer. 
8. Describe various types of characteristics of computer. 
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9. What is the storage devices present in computer? 
10. What is the Winchester Disk? 
11. Describe briefly the basic operations of computer. 
12. Explain the characteristics of each generation‟s computer. 
13. What is micro computer? Give its advantages & disadvantages. 
14. What is super computer? Give its advantages & disadvantages. 
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Chapter 2 
Windows XP 

Objective: 

 Windows XP 

 Features 

 Notepad 

 WordPad 
___________________________________________________________________________________________ 
Windows XP is the latest version of the Windows NT family of operating system. Windows XP is designed for 
business users and Windows XP home for consumers or home users. 

Features of Windows XP  
Some of the features are discussed below: 
Easier installation and updating: 

Win XP includes several features to make it easier to install and keep up to date. These include dynamic update 
and Windows update; the files and setting transfer wizard; more wizard for a variety of tasks; a wider selection of 
divide drivers; simplified installation for multifunction devices; and effective uninstall back to Windows 98 and 
Windows Me. 

Dynamic update and Windows update:  

When you are going to install Windows XP, one of the new features that you'll notice is the dynamic update, which 
offers you at the time of downloading to install latest patches, packages, and fixes and install them so that your 
copy of Windows XP is up to date. 

More wizards to make easier:  

Welcome to the network transfer wizard, which provides effective configuration of Windows network and internet 
connection sharing and the two hardware wizards, add hardware wizard and the found new hardware wizard. 

More Device drivers: 

Because of more device drivers there's is a better chance than another version of Windows (Windows 98, Windows 
Me or Windows 2000) that when you plug in a new device automatically Windows XP will be able to load the driver 
and get it working properly. Otherwise, for more benefits, you can install these devices with the help of proper drive 
which comes with device. 

Files and setting transfer wizard: 

Files and setting transfer wizard provides a way of transferring files and setting from one computer to other 
computer or from one installation of Windows to another on the same computer but you will still need to re-install 
your entire program on the new computer. 

Effective un-install back to Windows 98 and Windows ME:  

Windows XP have a great feature, an effective uninstall features for rolling back the Windows XP installation to 
your previous installation of Windows 98, Windows 98 second edition and Windows ME, but you can't revert from 
Windows NT and Windows 2000. 
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Redesigned Start menu: 

Windows XP sports a redesigned start menu that's supposedly easier and quicker to use. The default “Start menu 
“designed for Windows XP looks different from other version of Windows 9x. 

Eye Candy: 

Windows XP has a feature to define your pictures as a screen saver slide show. This is the prime example of eye 
candy and if your computer's hardware tends to be cool rather than hot, you may find the eye candy exactly an 
unacceptable performance penalty. 
Taskbar changes and enhancements: 

Windows XP includes a number of several options on taskbar but you can change the taskbar behavior back to 
how it was in previous version of Windows. 

Windows media player version 8: 

Windows media player is a combination of video and DVD player, CD player, an Internet radio tuner, and Jukebox 
for playing and organizing digital audio files such as WMA files and MP3 files. All DAT files that were not running 
smoothly in Windows 98 can be run easily in Windows XP platform. Windows media player is a huge improvement 
over the previous version in Windows 98. 

Windows Movie maker: 

These packages are used for capturing video, editing video and audio, also creating video files in the Windows 
media format. 

CD burning:  

CD burning capabilities are built in Windows XP. You can create a CD form windows explorer and also create from 
windows media player. 

Compressed Folders: 

Compressed files and folders are built in Windows XP. To zip, you don't need any software - WinZip 7 is present by 
default in windows XP.  

A more useful Winkey: Winkey? What is it? This is Windows key on the key board - the key with the Windows 
logo. It is located next to Alt+Ctrl keys. 

Some Winkey combinations are: -  

Winkey + Break Display system properties 

Winkey + Tab Move the control to the next button in the taskbar. 

Winkey + B Move the focus to the notification area. 

Winkey + D Display the desktop. 

Winkey + E Open the explorer window showing my computer. 

Winkey + F Open the search result window, activates search companion. 

Winkey + F1 Help and support 

Winkey + R Display the run dialog box 

Winkey + U  Display utility manager 

Winkey + L Locks the computer. 
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New version of internet explorer: 

Internet explorer version 6 is included in Windows XP. Compared to version 6, the new media bar makes it easier 
to listen to streaming audio directly in Internet Explorer. Internet Explorer 6 has built-in support for macromedia 
flash and Shockwave animations and support for cascading Style Sheets Level 1. The net result is that more 
animation will play without the need of additional software. 

MSN Explorer: Windows XP includes MSN Explorer. If you don't have an ISP, you may want to connect to the 
internet. 

Graphical User Interface (GUI) 

Now a days, everywhere you are getting pictorial representation of items like hoarding, banner, parking 
instructions, traffic signals etc. This is because pictorial presentations are independent of language so that any kind 
of person can understand the matter very easily and quickly without the help of interpreter. Software developers 
have opted for the advantage of this graphical representation to make understandable software or file or folder to 
the user. Presently almost all software have been developed based on this advantage which provides very user 
friendly environment for the user and most of the users are going for the same. This feature is known as Graphical 
User Interface (GUI). Some common Operating Systems are there that support GUI feature, like different versions 
of Windows, Open Server UNIX, OS/2, Novell Operating System (NOS) version 4.1 etc. 

Multitasking 

Multitasking refers to performing multiple tasks simultaneously. In Windows XP you are able to open multiple 
softwares as well as more than one document within same or different software simultaneously. You can easily 
move from one document/software to another using Taskbar or using Alt + Tab keys together. The number of 
software/documents that could be opened depend on the memory (RAM) capacity. This feature is known as 
Multitasking. 

 

Linking 
By this feature you can create a relation between two files so that when you change anything within source file, the 
target file will get affected as well as you can make any changes within source content by accessing directly the 
source file from the text file by double-clicking on the target area. The source file will open; whatever changes you 
are making should be saved under the original source file, the effect of which will also invariably come within target 
file. 
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Embedding 
As the word suggests, using this feature you can get a copy of the object within text document. But there will be no 
such relation with the original source file. As such, when you change anything within the source file, the same will 
not reflect the target file. 
Plug 'n' Play 
This feature helps activate any new hardware device by supplying proper device from the drive list of Windows XP. 
If the corresponding device driver is not available within Windows XP, operating system itself will give a prompt 
message to supply corresponding device driver to run the device. This unique process of Windows XP is known as 
Plug 'n' Play. To run this process, attach the hardware component and turn on the PC. Immediately operating 
system will check the new attachment through Plug 'n' Play program. If Windows XP is unable to provide the device 
driver to run the hardware, you have to supply this device driver externally, either by using CD or Floppy which will 
be supplied by the vendor at the time of purchase of device. If your PC is in working mode you can attach any new 
device with it or can replace any existing one, soon after attachment this Plug 'n' Play feature will start immediately. 
But this type of attachment is very risky for the computer. Any part of the computer can be crashed. It is better to 
avoid this method of attachment. 
For textual and designing purpose, Windows gives us the following applications: 

1.  NOTEPAD (Used for simple writing) 

2.  WORDPAD (Used for short document) 

3.  PAINT (Used for painting) 

Notepad 

Notepad is the default word processor of Windows XP. This software will be available after installation of Windows 
XP. Notepad is used to keep text, but it does not support any advanced text formatting. The files generated by 
Notepad are mainly known as text files. The default extension of Notepad file is .TXT. To open Notepad, go to Start 
menu > Programs > Accessories > Notepad. The following window will appear: 
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Multitasking. 

 

Linking 
By this feature you can create a relation between two files so that when you change anything within source file, the 
target file will get affected as well as you can make any changes within source content by accessing directly the 
source file from the text file by double-clicking on the target area. The source file will open; whatever changes you 
are making should be saved under the original source file, the effect of which will also invariably come within target 
file. 
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This window consists of Title bar, Menu bar, Scroll Bars and Text keeping area. To format text, choose the Edit 
menu > Set Font option. Here, you are able to change only Font face, Font size and Font style. Notepad does not 
support any Ruler, as there is no concept of text wrapping. If you want to write any content from a new line, you 
have to press Enter key. 
To save the file, go to File>Save> give the file name>save. 

 
Notepad Advantage 
If MS-Office is not installed in your machine and you want to keep some important text for future reference, you 
could use Notepad for that. This type of file can be opened from MS-DOS also and you could make any change 
directly within the file. 

WordPad 

WordPad is a text editor for short documents. This is a default word processor of Windows. This software will be 
available after installation of Windows XP. This is normally used to keep text matter within a document, where 
modification, formatting and printing of text also possible. The extension of WordPad file is .RTF. To open 
WordPad, go for Start menu > Programs > Accessories > WordPad. The following window will appear. 
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Components of WordPad 

1. Title Bar 
2. Menu Bar 
3. Standard Toolbar 
4. Formatting Toolbar 
5. Ruler 
6. Document Area 
7. Status Bar 

 
Working with WordPad 
After loading of WordPad, you will get a blank document. A blinking vertical line appears at the beginning of the 
document area, which is known as Cursor. It indicates the current position where text will be inserted. Here you 
keep text by typing from keyboard. To format any text matter, select the content by mouse dragging then either 
access Formatting toolbar or go for Format menu. Most of the menu options are similar as defined in Paint, but 
some new menus have been introduced, they are Insert and Format menus. 

Summary 

 CD burning capabilities are built in Windows XP. You can create a CD form Windows explorer and also 
create form windows media player. 

 This feature helps to active any new hardware device by supplying proper device from the drive list of 
Windows XP. If the corresponding device driver is not available within Windows XP, operating system itself 
will give a prompt message to supply corresponding device driver to run the device. 

 The extension of Notepad is .txt and the extension of WordPad is .wri. 

 
Assignment 

1. Answer the following question: 
i) What is Windows XP? 
ii) What do you mean by Multitasking? 
iii) What do you mean by Embedding? 
iv) What do you mean by Linking? 
v) What do you mean by Plug N Play? 
2. Open Notepad or WordPad and type the following (Minimum 3 times) and save the file with your name: 
 QWERTY U I O P A S D F G H J K L Z X C V B N M  
 Q w e r t y u I o p a s d f g h j k l z x c v b n m  
 A b C d E f G h I j K l M n O p Q r S t U v W x Y z 
 1234567890 
 123 456 789 / * - . + (using numeric keyboard) 
 @ ! ~ # $ % ^ & * (  ) - = _ +  / . , ' ; \ [  ]  ? >< ” : | { } 
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This window consists of Title bar, Menu bar, Scroll Bars and Text keeping area. To format text, choose the Edit 
menu > Set Font option. Here, you are able to change only Font face, Font size and Font style. Notepad does not 
support any Ruler, as there is no concept of text wrapping. If you want to write any content from a new line, you 
have to press Enter key. 
To save the file, go to File>Save> give the file name>save. 

 
Notepad Advantage 
If MS-Office is not installed in your machine and you want to keep some important text for future reference, you 
could use Notepad for that. This type of file can be opened from MS-DOS also and you could make any change 
directly within the file. 

WordPad 

WordPad is a text editor for short documents. This is a default word processor of Windows. This software will be 
available after installation of Windows XP. This is normally used to keep text matter within a document, where 
modification, formatting and printing of text also possible. The extension of WordPad file is .RTF. To open 
WordPad, go for Start menu > Programs > Accessories > WordPad. The following window will appear. 
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3. Which type of operating system is Windows XP? 
4. How you delete the files permanently in WIN XP? 
5. Which are the components present in desktop? 
6. Why we use icon? 
7. What is the function of shortcut? 
8. Write function of Recycle Bin. 
9. Describe different types of search procedure. 
10. Mention different types of views. 
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Chapter 3 
Windows XP 

Objective: 

 MS Paint 
___________________________________________________________________________________________ 

MS Paint 

MS-Paint serves the user in painting pictures/objects. By using Paint you can create, edit, and view pictures. You 
can paste a Paint picture into another document you've created, or use it as your desktop background. You can 
even use Paint to view and edit scanned photos. 

Start Paint 

Start menu >All Programs > Accessories > Paint, Paint window will appear. 
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Tools of Toolbox 

Free-form Selection  

To select non-uniform part of a picture, activate this tool then drag the pointer around the area. You can remove the 
selection box by clicking outside the box. 

Selection  

To select uniform part of a picture, use this tool. Select the tool and drag diagonally to select the area of drawing. 

Eraser/Color Eraser  

To erase a part of drawing, use Eraser tool. At the bottom of the toolbox, click an eraser shape. Drag the pointer 
over the area you want to erase. The selected background colour shows what colour the eraser will leave behind. 
You can change the background colour by right-clicking another colour in the colour box. You can change a 
specific colour by changing the foreground colour to the colour you want to erase and the background colour to the 
colour you want to replace it with. Then, when you click the eraser, you can right-click to change the colour. You 
can undo up to three changes by clicking Undo for each change from the Edit menu. 
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Fill with Color  

To fill an area or object with colour, use the tool. Place the mouse pointer anywhere inside the area of object, use 
left button to fill with current foreground colour and use right button to fill with background colour. If the shape being 
filled has any breaks in its border, the filling colour leaks through to the rest of the drawing area. You can find and 
close any openings by clicking the View menu, pointing to Zoom and then clicking Large Size or Custom. The 
default background and foreground colours appear at the left in the colour box. 

Eye Dropper  

To copy colour from one area or object to another, use Eye Dropper. Use left button to pick up the foreground 
colour and right button for background colours. 

Zoom  

Using this tool you can change the view of any part of the drawing for editing purpose. It can be maximized up to 
800%. At the bottom of the Toolbox a list of different zooming percentages will appear as 1x, 2x, 6x, 8x means 
100%, 200%, 600% and 800% respectively.  

Pencil  

To draw a free-form line, select the tool and drag it to draw a line. You can use left and right buttons to draw in 
foreground and background colours. 

Brush  

To draw any freehand drawing, use this tool. Here you are getting a facility to change the brush thickness as well 
as the brush shape for calligraphy drawing. To avail this facility, select the brush shape and size from the small 
box, which will appear at the bottom area of the toolbox. To draw anything, select the tool and drag the mouse 
pointer as required. 

Air Brush  

Use this tool for Spray printing. You are able to change the spray size by selecting proper size from the size box 
below the toolbox. Large size gives minimum density of colour and small size gives more density. To spray, drag 
the pointer. You can use left and right buttons to get foreground and background colours. 

Text  

To type and format text, use this tool. Select the tool and drag to make a text frame. Drag the pointer diagonally to 
the size you want. Text toolbar will appear immediately on the screen to format the text. If it is not available by any 
reason, go for View menu>Text Tool bar to activate the same. Text toolbar contains Fonts option, which you can 
apply for size, style, colour of text etc., you want for the selected text. Click inside the text frame, type the text, and 
then format the same if required. However, when the text tool is selected, you can paste text only. You cannot 
paste graphics. 
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Tools of Toolbox 

Free-form Selection  

To select non-uniform part of a picture, activate this tool then drag the pointer around the area. You can remove the 
selection box by clicking outside the box. 

Selection  

To select uniform part of a picture, use this tool. Select the tool and drag diagonally to select the area of drawing. 

Eraser/Color Eraser  

To erase a part of drawing, use Eraser tool. At the bottom of the toolbox, click an eraser shape. Drag the pointer 
over the area you want to erase. The selected background colour shows what colour the eraser will leave behind. 
You can change the background colour by right-clicking another colour in the colour box. You can change a 
specific colour by changing the foreground colour to the colour you want to erase and the background colour to the 
colour you want to replace it with. Then, when you click the eraser, you can right-click to change the colour. You 
can undo up to three changes by clicking Undo for each change from the Edit menu. 
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Line  
To draw a straight line you can use this tool. To draw a non-breakable horizontal, vertical or 45-degree diagonal 
line holding down the Shift key while dragging the mouse pointer. You can also change the line thickness if you 
need so. 
 

Curve  
Curve tool is used to draw a curve line. To draw a curve, first draw a straight line, and then drag the mouse pointer 
twice in any direction to make arcs. Each curve must have at least one arc but not more than two. 
 
Rectangle  
This tool is used to draw a rectangle or square. To draw a rectangle, select the tool and drag it diagonally. To draw 
a square, hold down the Shift key while dragging the mouse pointer. You can change the border thickness of the 
rectangle or square and also can opt for any style to draw the figure like only outline, fill with outline or only fill. To 
change thickness, select either Line or Curve tool then select Rectangle to get the same thickness in the drawing. 
Here you can use left and right buttons to use foreground and background colours. 
 

Polygon  
This tool is used to draw any closed area having more than two sides. To draw a polygon, drag the pointer and 
click at each corner, and then double-click when done. To use only 45-degreeand 90-degree angles, hold down 
Shift while dragging. You can create a colour filled polygon by clicking a fill style at the bottom of the toolbox. 
 

Ellipse  
Using this tool you can draw an ellipse or circle. Select the tool and drag the pointer diagonally. To draw a perfect 
circle, hold down Shift while you drag. You can create a colour filled ellipse or circle by clicking a fill style at the 
bottom of the toolbox. Click a new colour in the colour box to change the line colour, or right-click a new colour to 
change the fill colour. 
 

Rounded Rectangle  
Use of this tool is same as Rectangle tool. Specially, it provides rounded corners to the rectangle. 
 
Menus 
Paint or Paintbrush provides different menu options to manipulate a Paint file. Menus have been categorized 
depending on their area of work. For file manipulation you are getting File menu, similarly for any of drawing 
manipulation you have to work with Edit menu etc. It supports six menus altogether, such as File, Edit, View, 
Image, Colors and Help. 
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File Menu 

New 

This option is used to create a new file in Paint. If you are working with any file and you have selected this 
option, immediately it will ask whether you want to save changes within current file or not if the file is not saved, 
otherwise it provides directly a new file. The shortcut to invoke this option is Ctrl + N. 
Open 

This option is used to open any existing file of Paint. If you are working with any file, before opening the required 
one, it will ask whether you want to save current modifications or not and after getting confirmation it will close 
the current file and open the required one. The shortcut for this option is Ctrl + O. 

Save 

It is used to save any file permanently on the Hard disk, Floppy disk or Compact disk. If you are saving the file 
for the first time, Save As dialog box will appear which will ask for the filename. But if the file is already saved 
under a name, it cannot ask for another name, latest modifications will be saved under the previous name. The 
default extension of Paint file is .BMP, which will be added with the filename automatically. The shortcut for this 
option is Ctrl + S. 

Save As 

This option is also used to save a new file or an existing file under a new name. To save modifications of an 
existing file under a new name use this option that will allow you to give a new name. 

Print Preview 

This option provides a prior view of printing, so that you find out what will be the ultimate output through printer. 

Page Setup 

Using this option you can set the paper size of the document, orientation as well as margins can be set over 
here to get proper arrangement of contents on the document, also printout will be proper as per the 
arrangement. 

Print 

This option gives hardcopy or the printout on the paper through printer for currently opened document. It will 
provide a Print dialog box where you have to select the proper printer name, number of copies, range of pages 
to be printed, paper settings for the printer etc. The shortcut to invoke this dialog box is Ctrl + P. 

Exit 

This option allows closing Paint. If you are working with any file and click this option, it will ask for confirmations 
for saving and if you say “Yes” it finally closes Paint. To call this option shortcut is Alt + F4. 
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Line  
To draw a straight line you can use this tool. To draw a non-breakable horizontal, vertical or 45-degree diagonal 
line holding down the Shift key while dragging the mouse pointer. You can also change the line thickness if you 
need so. 
 

Curve  
Curve tool is used to draw a curve line. To draw a curve, first draw a straight line, and then drag the mouse pointer 
twice in any direction to make arcs. Each curve must have at least one arc but not more than two. 
 
Rectangle  
This tool is used to draw a rectangle or square. To draw a rectangle, select the tool and drag it diagonally. To draw 
a square, hold down the Shift key while dragging the mouse pointer. You can change the border thickness of the 
rectangle or square and also can opt for any style to draw the figure like only outline, fill with outline or only fill. To 
change thickness, select either Line or Curve tool then select Rectangle to get the same thickness in the drawing. 
Here you can use left and right buttons to use foreground and background colours. 
 

Polygon  
This tool is used to draw any closed area having more than two sides. To draw a polygon, drag the pointer and 
click at each corner, and then double-click when done. To use only 45-degreeand 90-degree angles, hold down 
Shift while dragging. You can create a colour filled polygon by clicking a fill style at the bottom of the toolbox. 
 

Ellipse  
Using this tool you can draw an ellipse or circle. Select the tool and drag the pointer diagonally. To draw a perfect 
circle, hold down Shift while you drag. You can create a colour filled ellipse or circle by clicking a fill style at the 
bottom of the toolbox. Click a new colour in the colour box to change the line colour, or right-click a new colour to 
change the fill colour. 
 

Rounded Rectangle  
Use of this tool is same as Rectangle tool. Specially, it provides rounded corners to the rectangle. 
 
Menus 
Paint or Paintbrush provides different menu options to manipulate a Paint file. Menus have been categorized 
depending on their area of work. For file manipulation you are getting File menu, similarly for any of drawing 
manipulation you have to work with Edit menu etc. It supports six menus altogether, such as File, Edit, View, 
Image, Colors and Help. 
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Edit Menu 

This menu consists of several options to modify drawing. 

Undo 

This feature allows the user to cancel the last operation(s). The shortcut is Ctrl + Z. 

Repeat 

This option helps you cancel Undo operation(s) i.e., if you have cancelled any operation using Undo and 
immediately if you want to cancel the cancelled effect from your document, then you have to cancel the current 
cancellation using Repeat command. It totally depends on the Undo option, if you have used Undo option twice 
successively, the option repeat also can be used twice. The shortcut of this option is F4. 

Cut 

It is used to remove any selected portion of drawing. The shortcut of this option is Ctrl + X. 

Copy 

This option is used to send a copy of the selection from drawing area. The shortcut is Ctrl + C. 

Paste 

This option is used to call back the clipboard content to the document area. Whenever you send any matter to 
the clipboard using Cut or Copy option, it will keep only the latest content and the previous matter will get 
overwritten with the latest one. The shortcut of this option is Ctrl + V. 
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